
 

DCN Next Generation 
Multi Voting 

 

en Software User Manual 
LBB 4176/00 

 



 

About this manual 
This user manual is divided into five chapters. 
Chapters 1 and 2 provide background information, 
chapters 3 and 4 provide detailed user information 
and chapter 5 provides import and export 
information as follows: 
• Chapter 1 - Multi Voting - containing a brief 

overview of the Digital Congress Network Next 
Generation and an overview of the functionality 
of the Multi Voting application. 

• Chapter 2 - Getting Started - containing details of 
how to start the Multi Voting application from 
the Startup screen and a description of the Help 
facility. 

• Chapter 3 - Preparing for a Conference - containing 
details about how to prepare for a voting session; 
creating and editing votings, specifying vote 
settings and type, display contents and styles, 
working with script files, and printing. 

• Chapter 4 - Controlling Voting - containing details 
about how to initiate and control a voting session, 
voting with a script, voting without a script, and 
how to exit Multi Voting. 

• Chapter 5 – Voting import/export - contains details 
about the import scripts and exported files. 

 

Manual conventions 
For clarity this user manual uses consistent styles, 
symbols and typographical conventions. They are: 
 

 i   Note 

General notes are contained within rules and 
indicated with this symbol in the left margin. 
Notes are used to draw attention to special 
actions or information. 

 

 i   Caution 

A caution is contained within rules and 
indicated with this symbol at the left margin. 
Cautions are used to draw attention to actions 
or commands that could lead to a loss of 
information or damage to equipment 

 

 i   Tip 

A tip is contained within a box and indicated 
with this symbol at the left margin. Tips are use 
to provide supplementary information that may 
make an action quicker or easier to carry out. 

 

• An action (to be carried out by the user) is shown 
with a larger round bullet mark. 

Typographical conventions 
The following typographical conventions (text styles) 
are used in this manual: 
• Typed input - information to be typed in using 

the keyboard is shown as: 
Filename 

• Single key - input via a single key (or keys) on 
the keyboard is shown as: 

<enter>, <shift>, etc. 
• Multiple keys - input via a combination of keys 

pressed together is shown as: 
<ctrl>+<p>, <alt>+<f4> 

• Screen text - information that appears on screen 
is shown as: 

‘Choose Startup Modules:’ 
 
Hyperlinks 
This manual is also available as a digital document in 
the Adobe Portable Document Format (PDF). All 
references to pages, figures, tables, etc. in this digital 
document contain hyperlinks to the referenced location. 



DCN Next Generation Multi Voting en | 3 

 

Bosch Security Systems B.V. | 2005 September | 9922 141 70392 

Table of contents 
 
 
1 Multi Voting ...............................................................................4 
1.1 About multi voting ................................................... 4 
1.1.1 What is multi voting?.............................................. 4 
2 Getting started ........................................................................6 
2.1 Starting multi voting................................................ 6 
2.1.1 The Startup screen ................................................. 6 

Selecting an installation- (and a names) file............... 6 
The Multi Voting icon ....................................................... 6 

2.2 Using Help ................................................................ 6 
2.2.1 The Help menu......................................................... 6 
2.2.2 Index ........................................................................... 6 
2.2.3 Keyboard ................................................................... 7 
2.2.4 Commands ............................................................... 7 
2.2.5 Procedures ............................................................... 7 
2.2.6 Glossary .................................................................... 7 
2.2.7 Using Help ................................................................ 7 
2.2.8 About.......................................................................... 7 
3 Preparing for a conference...............................................8 
3.1 The preparation window........................................ 8 

The menu bar for the control screen............................ 8 
3.2 Working with script files ........................................ 8 

Creating a new script file................................................ 9 
Opening an existing script file ....................................... 9 
Saving a script file ............................................................ 9 
Saving a script file under a new name......................... 9 
Deleting a script file .......................................................10 
Importing a script file .....................................................10 
Printing Multiple Choice results ..................................10 
Exporting Multiple Choice results...............................11 

3.3 Creating and editing votings ..............................11 
Creating new votings.....................................................11 
Entering voting description parameters ....................11 
Voting number .................................................................11 
Voting name .....................................................................12 
Voting kind........................................................................12 
Voting description...........................................................12 

3.3.1 Voting answers ......................................................12 
3.3.2 Entering voting results parameters ...................13 

Open or closed vote ......................................................13 
Specifying interim results..............................................13 

3.3.3 Specifying viewing parameters ..........................13 
Enabling 2 results ...........................................................13 
Specifying that results are displayed for each 
answer ...............................................................................13 
Specifying delegate names in roll call voting...........14 
Enabling correct indication...........................................14 
Specifying results as percentages .............................14 
Specifying results as absolute values........................14 
Displaying results in bar chart form............................14 
Displaying results in pie chart form ............................14 
Displaying results in thermometer chart form..........14 

3.3.4 Inserting into the voting list .................................15 
3.3.5 Editing existing votings ........................................15 

Search ...............................................................................15 
3.3.6 Editing the current script file ..............................16 

Inserting votings into the current script file ..............16 
3.3.7 Deleting votings in the current script file .........16 

3.4 Viewing results during or after voting .............. 16 
Specifying which results are displayed.....................17 

3.5 Specifying settings ............................................... 18 
3.5.1 Specifying timed vote .......................................... 18 
3.5.2 Specifying screen and print legends................ 18 
3.5.3 Specifying open and closed voting .................. 19 
3.5.4 Specifying 100% votes....................................... 19 
3.5.5 Specifying roll call................................................. 20 
3.5.6 Specifying auto abstain ....................................... 20 
3.5.7 Enabling the chairman to vote ........................... 20 
3.5.8 Applying vote weighting...................................... 20 
3.5.9 Specifying that votes are not revocable .......... 20 
3.5.10 Enabling the voting LEDs on delegate units .. 20 
3.5.11 Sending voting results to hall displays ............ 20 
3.5.12 Specifying quorums and majorities .................. 21 

Specifying quorums .......................................................21 
Specifying majorities......................................................22 
Enabling Quorum and Majority....................................23 
Approved Text .................................................................23 

3.5.13 Exporting results automatically .......................... 24 
3.6 Printing .................................................................... 24 
3.6.1 Printing script files ................................................ 24 
3.6.2 Printing voting results .......................................... 24 

Print a multiple choice report.......................................26 
3.6.3 Printing voting results automatically ................. 26 
4 Controlling voting................................................................28 
4.1 The control window.............................................. 28 
4.2 Voting without a script......................................... 28 
4.3 Voting using a script ............................................ 29 

Selecting a voting...........................................................29 
Selecting the next voting ..............................................29 
Selecting the previous voting ......................................29 

4.3.1 Selecting a quorum and majority....................... 29 
Selecting a quorum........................................................29 
Selecting a majority........................................................30 

4.3.2 Starting voting ....................................................... 30 
4.3.3 Controlling voting.................................................. 30 
4.4 Exiting Multi Voting ............................................... 30 
4.4.1 Temporarily exiting Multi Voting......................... 30 
4.4.2 Permanently exiting Multi Voting ....................... 30 
5 Voting import/export.........................................................32 
5.1 Introduction ............................................................ 32 
5.2 Import voting script............................................... 32 
5.2.1 Introduction ............................................................ 32 
5.2.2 Import file layout .................................................... 32 
5.3 Export voting results............................................. 33 
5.3.1 Introduction ............................................................ 33 
5.3.2 Results export file layout ..................................... 33 

Identification.....................................................................34 
Answer legend ................................................................34 
Date and time ..................................................................34 
Total results......................................................................34 
Individual results..............................................................35 

5.4 Export Multiple Choice voting script + results
 35 



DCN Next Generation Multi Voting en | 4 

 

Bosch Security Systems B.V. | 2005 September | 9922 141 70392 

5.4.1 Introduction.............................................................35 
5.4.2 Script + results export file layout.......................35 

Identification.....................................................................35 
Voting info.........................................................................35 
Individual results..............................................................36 

1 Multi Voting 

1.1 About multi voting 

1.1.1 What is multi voting? 
The Multi Voting module is a software module 
designed for controlling and monitoring conferences 
and discussions using the contribution equipment. 
 
The module allows you to effectively implement and 
manage voting at a conference. The program covers 
a number of functions including vote preparation, 
specifying vote-related parameters, and starting and 
controlling voting. In Multi Voting there are six 
different kinds of voting to choose from. You can 
create motions for voting then select which kind of 
vote you want to use. The six different kinds of 
voting are: 
 
Parliamentary voting - in a Parliamentary voting, 
participants vote about a motion. They can agree 
(Yes), disagree (No) or stay neutral (Abstain). They 
can also not vote at all (Not voted). A special type of 
parliamentary vote is with NPPV as a forth option. 
NPPV (‘ne prennent pas part au vote’) means that the 
delegate doesn’t want to participate in the vote (used 
in France). 
 
For/Against voting - in a for/against voting, 
participants vote about a statement. They can agree 
(For) or disagree (Against). They cannot stay neutral 
other than by not casting a vote. 
 
Audience Response voting - in an audience 
response voting, participants give their opinion about 
a statement. They use a rating system to indicate how 
much they agree with the statement. There are five 
possible answers: Very much against (--), Against (-), 
Neutral (0), For (+) and Very much for (++). 
 
Rating - in a Rating voting, participants give their 
opinion about a statement. There can be between 2 
and 24 answer options. 
 
Multiple Choice voting - in a multiple choice 
voting, participants choose from a number of answers 
of which only one (or sometimes a few) is correct. 
Not casting a vote is considered an incorrect answer. 
There can be between 2 and 24 answer options. 
 

Opinion Poll - in an opinion poll, participants 
choose from a number of answers. There can be 
between two and 24 answer options. 
 
The module has two main windows; the Preparation 
window and the Control window. The preparatory 
and parameter definition work is mainly carried out 
from the Preparation window, and the starting and 
controlling of voting is carried out from the Control 
window. The files created using this module are 
called script files as they act as the script for voting 
procedures. For Multi Voting, three kinds of script 
file are possible depending on the kind of votings it 
contains: 
• Multi votings only 
• Multiple choice votings only 
• A combination of voting kinds. 
 
By creating, deleting and editing votings the script 
file can change from one type to another. 
 
A file menu allows script files to be opened, created, 
deleted, saved, saved under a different name, 
imported and printed out. 
 
A script file consists of a number of votings (between 
1 and 9999), each of which is a proposal (or motion) 
that will be voted on. New votings can be created 
and existing ones edited within script files. Votings to 
be edited are selected from a list in the currently 
open script file and displayed on-screen. All 
parameters related to this voting can be altered, 
although certain parameters have to satisfy system-
specified criteria. Once a voting has been edited it is 
inserted back into the list. Every voting must have a 
unique number, which is used by the system as a 
reference. The name and description of each voting 
defines it for both users and delegates. 
 
Once a voting is ready to be voted on, it is recalled 
in the Control window and the voting process is 
started. When the program enters the active voting 
state, delegates can use their delegate units to register 
votes. The user has full control over the voting 
procedure, and can stop or suspend a vote at any 
time. Motions that have already been voted on 
cannot be edited, but voting again on the same 
motion is possible. It is also possible to vote without 
opening a script file. 
 
The program offers the possibility of displaying 
incoming votes or the final result of a vote on hall 
displays connected to the system, on delegate units 
with a display facility, and on-screen. It is possible to 
print out a hard copy of a voting with its results. 
There is also a facility which automatically prints out 
the results of a vote once voting is completed. 
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Voting results shown as a percentage are given to 
one decimal place. For a Multi voting, the exact 
percentage is always rounded down to obtain the one 
decimal place figure; for instance, 50.99% is rounded 
down to 50.9%. This prevents a percentage being 
rounded up to the majority limit when in fact the 
limit has not been reached. The leftover percentage, 
in this case 0.09%, is added on to the ‘not voted’ or 
the ‘abstain’ figure. If neither is possible, it will be 
added to the ‘no’ vote. In this way the total 
percentage will always be 100. 
 
It is also possible to enable a quorum function. This 
specifies how many authorized delegates must be 
present before a voting can legitimately take place. A 
majority function can also be enabled which 
determines what percentage of votes constitutes a 
majority voting. 



DCN Next Generation Multi Voting en | 6 

 

Bosch Security Systems B.V. | 2005 September | 9922 141 70392 

2 Getting started 

2.1 Starting multi voting 

2.1.1 The Startup screen 
The Multi Voting program is started from the Startup 
screen (shown below). 

 

Figure 1 The Startup screen 

 

 i   Note 

For starting the Startup program from an icon 
in the Windows desktop, refer to the Startup 
user manual. 

 
The software uses two user-created files that contain 
important information about the installed hardware 
configuration and about delegates’ names. These files 
are: 
• Installation file - containing information about 

channel assignment and the numbers that have 
been assigned to all microphones connected to 
the system. These seat numbers are assigned 
using the System Installation software (LBB 4185). 

• Names file - containing information about the 
name, seat number and other conference and 
personal details of participating delegates. Names 
files are created using the Delegate Database 
software (LBB 4180). 

 
The software modules may be started up from the 
Startup main window without specifying either an 
installation or names file. However, some software 

modules will not run without the appropriate 
installation or names file. 
 
Multi Voting requires an installation file in order to 
function correctly. It also makes use of one specific 
area of information contained within the names file; 
the assigning of delegates to user-specified groups 
within the conference. The results of the voting of 
these groups can be displayed in the Results window 
of Multi Voting, but only if the appropriate names 
file containing these group assignments is specified 
from the Startup menu. If no names file is selected 
from the Startup main menu, the group results 
display option in Multi Voting will not be available. 

Selecting an installation- (and a names) file 
For details on selecting an installation- (and a names) 
file, please refer to the Startup user manual (LBB 
4190). 
 

 

The Multi Voting icon 
For details on the Intercom icon and how to start 
Intercom from Startup, please refer to the Startup 
user manual (LBB 4190). 

2.2 Using Help 

2.2.1 The Help menu 
The ‘Help’ menu in the title bar contains commands 
for an on-screen help facility. This help facility 
contains information on all commands in the ‘File’ 
menu, on which keyboard keys are functional, a 
description of how to use the software, information 
on how to use the help facility itself, plus an index 
and a glossary of terms. All information contained in 
this user manual is also found in the ‘Help’ facility. 
 
The ‘Help’ facility contains the following options: 
• Index 
• Keyboard 
• Commands 
• Procedures 
• Glossary 
• Using Help 
• About Multi Voting. 

2.2.2 Index 
To access the index: 

• Select the ‘Help’ menu and click on ‘Index’. 

A full list of subjects covered by the help facility is 
given in alphabetical order. For more information on 
any subject contained in the index: 

• Click on the required subject in the index. 
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An on-screen page with the requested information 
will appear. 

2.2.3 Keyboard 
This gives information on which keys on your 
keyboard can be used with the software. This 
includes using keys to activate menu items, to move 
around in dialogue boxes, for short cuts, and to select 
options from the main window. To access the 
‘Keyboard’ help facility: 

• Select the ‘Help’ menu and click on ‘Keyboard’. 

A list of different key types is given. For more 
information on any key type contained in the list: 

• Click on the required key type in the list. 

An on-screen page with the requested information 
will appear. 

2.2.4 Commands 
This gives information on all menu options, covering 
the ‘File’, ‘Edit’, ‘View’, ‘Settings’ and ‘Help’ menus. 
To access the ‘Commands’ help facility: 

• Select the ‘Help’ menu and click on ‘Commands’. 

A list of menu groups is given. For more information 
on any menu group contained in the list: 

• Click on the required menu group in the list. 

A list of options in the selected menu group is given. 
For more information on any option contained in the 
list: 

• Click on the required option in the list. 

An on-screen page with the requested information 
will appear. 

2.2.5 Procedures 
This gives information on how to use the software. 
To access the ‘Procedures’ help facility: 

• Select the ‘Help’ menu and click on ‘Procedures’. 

A list of topics is given. For more information on any 
topic contained in the list: 

• Click on the required topic in the list. 

A list of options for the selected topic is given. For 
more information on any option contained in the list: 

• Click on the required option in the list. 

An on-screen page with the requested information 
will appear. 

2.2.6 Glossary 
To access the glossary: 

• Select the ‘Help’ menu and click on ‘Glossary’. 

A list of terms used in the help facility is given in 
alphabetical order. For more information on any 
term contained in the glossary: 

• Click on the required subject in the index. 

A window with the requested information will appear. 

2.2.7 Using Help 
This gives information on how to use the help facility. 
To access the ‘Using Help’ facility: 

• Select the ‘Help’ menu and click on ‘Using Help’. 

A list of topics is given. For more information on any 
topic contained in the list: 

• Click on the required topic in the list. 

A list of options for the selected topic is given. For 
more information on any option contained in the list: 

• Click on the required option in the list. 

An on-screen page with the requested information 
will appear. 

2.2.8 About 
This provides software release information. To 
display the ‘About Multi Voting...’ window: 

• Select the ‘Help’ menu and click on ‘About Multi 
Voting...’. 

The following window appears: 

 

Figure 2 The ‘About Multi Voting...’ window 

To remove this window: 

• Click on the ‘OK’ push button. 
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3 Preparing for a conference 

3.1 The preparation window 
The Preparation window of the Multi Voting module 
is used to prepare votings. From this window it is 
possible to create new votings and edit existing ones. 
You can also access the ‘File’ menu. You can enter 
the Preparation window from the Control window as 
follows: 

• Click on the ‘Preparation!’ menu option situated 
on the menu bar of the Control window. 

The Preparation window appears: 

 

Figure 3 The Preparation window 

The Preparation window contains the following 
elements: 
• ‘Number’ and ‘Name’ edit fields 
• ‘Kind’ drop-down list box 
• ‘Subject’ dialogue box 
• ‘Interim Results’ drop-down list box 
• ‘Open’ voting and ‘Closed’ voting radio buttons 
• ‘Answers’ push button 
• A list box of current votings 
• ‘Search’ radio buttons, push button and edit box 
• ‘Recall’, ‘Insert’ and ‘Delete’ push buttons 
 
If there is a script file currently open, the name of the 
script file will be displayed in the title bar at the top 
of the Preparation window. Votings contained within 
that script file will be displayed in the list box on the 
right hand side of the Preparation window. If there 
are more votings than can be displayed, a scroll bar 
is available. If a voting is currently selected, the 
‘Number’, ‘Name’ and ‘Kind’ text fields and the 
‘Subject’ text box will contain information relating to 
the selected voting. When a script file is opened, the 
first voting (voting number 1) is automatically 
selected. 
 

 i   Note 

For details on opening a script file, please refer 
to page 9. 

 

The menu bar for the control screen 
All menu options referred to in this user manual are 
contained within the menu bar, located underneath 
the title bar at the top of the Control window. Access 
to drop-down menus is gained by clicking on the 
menu title, displayed in the menu bar. The full list of 
menu options available from the Control window is 
given below. It is also possible to access the ‘File’ and 
‘Help’ menus from the Preparation window. 
 
File Settings Results Preparation! Help 
     
New… 
 
Open… 
 
Save 
 
Save As… 
 
Delete… 
 
Print Script… 
 
Print Results… 
 
Import 
Scripts… 
 
Multiple Choice 
 
Copy Votings… 
 
Exit 

Voting Timer 
 
Edit Legends 
 
100% Votes 
 
Open 
 
Close 
 
Roll Call 
 
Auto Abstain 
 
Voting Chairman 
 
Vote Weighting 
 
Vote Not 
Recoverable 
 
Voting LED’s 
 
To Hall Displays 
 
Attention Tones ► 
 
 
 
 
 
Quorum/Majority  ► 
 
Automatic Printing 
 
Automatic Export 

Results Window 
 
2 Results 
 
Answers 
 
Name 
 
Correct 
Indication 
 
Percentage 
 
Absolute 
 
Bar 
 
Pie 
 
Thermometer 
 
 
 
 
 
Off 
 1 
 2 
 3 
 4 
 
Edit Quorums 
Edit Majority 
Approved Text 
Quorum 
Majority 
 

 Index… 
 
Keyboard 
 
Commands 
 
Procedures 
 
Glossary 
 
Using Help 
 
About Multi 
Voting… 

 

3.2 Working with script files 
If you wish to use another script file or open a 
completely new one, the ‘File’ menu includes 
commands for doing so. This menu has commands 
for: 
• Creating a new script file 
• Opening an existing script file 
• Saving a script file 
• Saving a script file under a different name 
• Deleting a script file 
• Printing a voting and its results from the current 

script file 
• Importing a script file from outside the Multi 

Voting application 
• Copying votings from one script file to another 
• Exiting the Multi Voting program. 
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 i   Note 

Leaving the Multi Voting program is not 
covered in this section, but under ‘Exiting Multi 
Voting’ in paragraph 4.4. Similarly, printing is 
covered in paragraph3.6, and copying in 
paragraph 3.3.6. 

Creating a new script file 
To open a new script file: 

• Select the ‘File’ menu and click on ‘New...’. 

The following dialogue box appears: 

 

Figure 4 The ‘New’ dialogue box 

This dialogue box contains a text box for entering 
the script file name. When the ‘New’ dialogue box 
opens, a text insertion point is already in the text box 
and you can type a name up to 12 characters long. 

• Type the desired script file name in the text box. 

• Click on the ‘Ok’ push button. 

A new script file opens and the name appears in the 
title bar at the top of the window. The ‘Current’ list 
box will be empty, and all existing information 
relating to votings, scripts and results is removed. If 
you attempt to open a new script file before saving 
changes to the current one, a warning message with 
the following text is displayed: 

‘Changes have been made to <filename>.’ 
‘Do you want to save?’ 

• Click on the ‘Yes’ push button to save the 
changed script file and open the new script file. 

• Click on the ‘No’ push button to open the new 
script file without saving the changed script file. 

• Click on the ‘Cancel’ push button to leave the 
‘New’ dialogue box without opening a new script 
file. 

 i   Note 

If you have entered a filename that already 
exists, a warning message with the following 
text is displayed: ‘A file already exists with 
this name’. 

 

• Click on the ‘Ok’ push button to return to the 
dialogue and enter a valid name. 

Opening an existing script file 
To open an existing script file: 

• Select the ‘File’ menu and click on ‘Open’. 

The following dialogue box appears: 

 

Figure 5 The ‘Open’ dialogue box 

There is a list box for selecting the script file name. 
The name of the script file currently open is also 
displayed. When the ‘Open’ dialogue box appears, a 
list box is shown with all script files currently 
available. To open a script file: 

• Click on the name in the list. 

• Click on the ‘Ok’ push button. 

If you attempt to open a script file before saving 
changes to the current one, the same error message 
will appear as for ‘Creating a new script file’. The 
same procedure should be followed. For more 
details, refer to page 9. 
 
The selected script file will be opened. The votings of 
that script file are displayed in the ‘Current’ list box. 

Saving a script file 
To save the current script file: 

• Select the ‘File’ menu and click on ‘Save...’. 

All parameters in the current script file will be saved, 
except voting information, which has not yet been 
inserted into the ‘Current’ list. 

Saving a script file under a new name 
This allows you to save the current script file under a 
different name. By doing so, the original file remains 
unaltered. To do so: 

• • Select the ‘File’ menu and click on ‘Save As...’. 
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The following dialogue box appears: 

 

Figure 6 The ‘Save As’ dialogue box 

When the ‘Save As’ dialogue box opens, a text 
insertion point is already in the text box and you can 
enter a new name up to 12 characters long. 

• Type the new script file name in the text box. 

• Click on the ‘Ok’ push button. 

The new name appears in the title bar at the top of 
the window. If you have typed in a filename that 
already exists, a warning message with the following 
text is displayed: 

‘A file already exists with this name’ 

• Click on the ‘Ok’ push button. 

The dialogue box returns and a valid name can be 
typed in. 

Deleting a script file 
If you wish to delete a script file: 

• Select the ‘File’ menu and click on ‘Delete...’ 

The following dialogue box appears: 

 

Figure 7 The ‘Delete’ dialogue box 

This dialogue box contains a list box for selecting the 
script file to be deleted. To delete a script file: 

• Click on the name in the list. 

• Click on the ‘Delete’ push button. 

Another dialogue box will appear, with the text: 

‘Are you sure you want to delete file 
<filename>?’ 

If you still wish to continue: 

• Click on the ‘Ok’ push button. 

The selected file will be deleted. 

Importing a script file 
It is possible to import a script file from outside the 
Multi Voting application. To import a script file: 

• Select the ‘File’ menu and click on ‘Import 
Script...’. 

The following dialogue box appears: 

 

Figure 8 The ‘Import Script’ dialogue box 

This is a standard windows dialogue box and 
contains a text box where you can type the name of 
the file to be imported. Files to be imported must be 
DOS files and have an .imp file extension. 
To continue: 

• Enter the name of the file to be imported. 

• Click on the ‘Ok’ push button. 

The selected file will be imported. The file will 
automatically be added to the list of script files in the 
‘Open’ dialogue box. 
 

 i   Caution 

If there is already a script file in Multi Voting 
with the same name as the imported file, the 
existing file will be overwritten. There is no 
warning message.  
You can also select a file by clicking on the file 
name in the list box underneath the text box. 
Two list boxes on the right hand side of the 
dialogue box allow you to select directories and 
drives respectively. 

• Double click on the file to be imported. 

Printing Multiple Choice results 
It is possible to print Multiple Choice results. The 
report contains information about the script file and 
the voting results for each question contained in it.  
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 i   Note 

This is only possible if the script contains 
Multiple Choice questions and no information 
of other voting types. 

 

 i   Note 

When a Multiple Choice script file contains 
more than 40 questions, the file is no longer 
regarded as being a Multiple Choice script file 
and cannot be printed. 

 
To print a Multiple Choice voting script: 

• Select the ‘File’ menu and click on ‘Multiple 
Choice’. 

• From the sub-menu click on ‘Print Report...’. 

The following dialogue box will appear: 

 

Figure 9 The 'Print MC Report' dialogue box 

In the ‘Page Header’ edit field: 

• Enter the page header. 

• Select if only the total result must be printed. 

• Select the number of printed copies 

• Click on the ‘Print’ push button. 

The result will be printed. 
 

Exporting Multiple Choice results 
It is possible to export Multiple Choice results into a 
DOS file. This report contains information about the 
script file and the voting results for each question 
contained in it. The file is exported to the directory: 
..:\DCNNG\EXPORT\MV 
 
 
 

 i   Note 

This is only possible if the script contains 
Multiple Choice questions and no information 
of other voting types. 

 

 i   Note 

When a Multiple Choice script file contains 
more than 40 questions, the file is no longer 
regarded as being a Multiple Choice script file 
and cannot be exported. 

 
To export a Multiple Choice voting script: 

• Select the ‘File’ menu and click on ‘Multiple 
Choice’. 

• From the sub-menu click on ‘Export Report...’. 

The following dialogue box will appear: 

 

Figure 10 The 'Export MC Report' dialogue box 

In the ‘File’ edit field: 

• Enter the destination file to which the script is  
exported. 

• Click on the ‘Export’ push button. 

The result file will be exported. 

3.3 Creating and editing votings 
All editing and creating of votings is carried out from 
the Preparation window. 

Creating new votings 
You can create new votings within an existing script 
file or in a completely new one. The procedure for 
doing so is exactly the same in both cases. 

Entering voting description parameters 
These options allow you to enter the parameters that 
define a voting. 
 

Voting number 
This number gives the voting a unique reference and 
is used by the system as a means of identification. It 
appears alongside the voting name in the ‘Current’ 
list, hall displays and delegate units fitted with 
displays. The voting number must be in the range 
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0001 to 9999 and must be unique. If it is not, a 
warning message will appear when you attempt to 
insert the edited voting back into the ‘Current’ list, 
and the insertion will not take place. To edit the 
voting number: 

• Click on the ‘Number’ edit field. 

• Type in the required voting number. 

 

 i   Tip 

You can also use the up and down buttons to 
the right of the edit field to access the next 
highest or next lowest available voting number. 

 

 i   Note 

The next voting number appears after you insert 
a voting. 

Voting name 
This name appears in the ‘Current’ list. The 
maximum length of a voting name is 20 characters. 
To edit the voting name: 

• Click on the ‘Name’ edit field. 

• Type in the required voting name. 

Voting kind 
This describes the type of voting. Six different kinds 
of voting are possible in Multi Voting: 
• Parliamentary voting 
• For/Against voting 
• Audience Response voting 
• Rating 
• Multiple Choice voting 
• Opinion Poll voting 
 
For more information about voting types and 
options, please refer to paragraph 1.1.1 
 
The ‘Kind’ drop-down list box - where the 
description is selected – contains the six choices. To 
select the voting kind: 

• Use the up and down arrow keys to view the 
choices. 

• Click on the required selection. 

Voting description 
This is text that describes the voting. The voting 
description can appear on hall displays and LC 
displays of delegate units. The ‘Subject’ edit field - 
where the description is entered - contains four text 
lines. To enter or edit a voting description: 

• Click on the ‘Subject’ edit field. 

• Type in the required voting information. 

3.3.1 Voting answers 
You can specify the number of answer options, the 
LCD text and the answer text, which will form each 
voting option in the current voting. 
Answer text cannot be displayed on delegate units 
and can only be specified for Multiple Choice and 
Opinion Poll voting. To select the number of 
answers: 

• Click on the ‘Answers’ push button in the 
Preparation window. 

The ‘Answers’ dialogue box will appear: 

 

Figure 11 The ‘Answers’ dialogue box 

To specify the number of answer options: 

• Select the ‘Number’ edit field and type in the 
required value. 

The up and down arrow buttons on the right-hand 
side of this field can be used to scroll to the required 
number. 
 

 i   Note 

If the voting kind is For/Against voting or 
Audience Response voting, the number of 
answers is selected automatically by the 
system. 

 
You can specify the LCD text, which is the text that 
will appear on delegate units. The options available 
will vary according to the voting kind. To do so: 

• Select the ‘LCD’ drop-down list box. 

• Click on the required option. 

For Multiple Choice and Opinion Poll voting, it is 
possible to specify answer text for answer options. 
Each answer option is displayed as a text edit field in 
the ‘Answer’ display area. If legend text has been 
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specified, this appears to the left of each answer 
option. For information about specifying legend texts, 
see paragraph 3.5.2. 
 
If the number of answer options is greater than five, a 
scroll bar is active and can be used to scroll up or 
down to the required option. To enter answer text: 

• Click on the required edit field and enter the 
required text. 

You can specify if one or more answer options are 
correct: 

• Click on the required ‘Correct’ tick box. 

A tick (√ ) indicates that the answer option is correct. 
When you have finished specifying parameters: 

• Click on the ‘Close’ push button. 

You will return to the Preparation window. 

3.3.2 Entering voting results parameters 
These options allow you to edit the parameters that 
define the vote type and how the vote results are 
displayed. 

Open or closed vote 
An open vote is one in which individual and group 
results can be displayed. An open vote is only 
possible if a names file in the Delegate Database 
module is open. A closed vote is one in which no 
individual or group results can be displayed, only the 
total votes cast. To specify the vote type: 

• • Click on the ‘Open’ or ‘Closed’ radio button in 
the Preparation window. 

A black circle will appear in the selected radio 
button. 

Specifying interim results 
It is possible to view voting results while the voting is 
still taking place. When such interim results are 
shown they are updated every second. The ‘Interim 
results’ drop-down list box in the Preparation 
window determines if, where and in what form 
interim results are presented. They can be displayed 
on PCs, delegate units and hall displays. No interim 
results will be visible on delegate units if the number 
of answer options is greater than five. There are five 
choices: 
• None - no interim results are visible. 
• Total - only total interim results are visible. They 

are displayed on the control PC, hall displays 
and delegate units (if the number of answer 
options is less than five). 

• Individual + Total - both total and individual 
results will be displayed as above. 

• Total on PC only - only total interim results will 
be shown solely on the control PCs. After voting 

is stopped, it is possible to send the results to hall 
displays. 

• Individual + Total on PC only - total and 
individual interim results will be visible only on 
the control PCs. After voting is stopped, it is 
possible to send the results to hall displays. 

 
Total results are results displayed for the total 
number of delegates. Individual results are results 
displayed separately for each delegate. Group results 
are results displayed for each group (if any) specified 
in the Delegate Database module. 
 

 i   Note 

Individual and group results are only available 
when a voting is open. 

 
To specify the interim results setting: 

• Use the up and down arrow keys to view the 
options. 

• Click on the required option. 

3.3.3 Specifying viewing parameters 
You can specify how the voting results are displayed 
in the Results window. This is carried out from the 
‘Results’ menu, which can only be accessed from the 
Control window. 

Enabling 2 results 
This option allows you to specify whether the results 
of two separate votings from the current script are 
displayed alongside each other in the Results 
window. The current voting is displayed on the left 
hand side of the results display area and another 
voting can be chosen from the current script to be 
displayed on the right hand side. If this option is 
selected, the ‘Answers’ option is automatically 
deselected. To enable or disable this option: 

• Select the ‘Results’ menu and click on ‘2 
Results’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 
 

 i   Note 

‘2 Results’ and ‘Answers’ cannot both be 
selected simultaneously. 

 

Specifying that results are displayed for each 
answer 
This option is used with Multiple Choice and 
Opinion Poll voting. To specify this option: 
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• Select the ‘Results’ menu and click on 
‘Answers’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

Specifying delegate names in roll call voting 
This option allows you to display the voting 
delegate’s name at the bottom of the Results window 
during a roll call voting. Roll call voting determines 
the way that participants can vote. If it is enabled 
participants must vote sequentially in an order 
determined by the database application. If it is 
disabled participants can vote in any order. To 
enable this option: 

• Select the ‘Results’ menu and click on ‘Name’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

Enabling correct indication 
This option is used with Multiple Choice and 
Opinion Poll voting. It allows you to specify that a 
correct answer option is highlighted in a different 
color from the other answer options on hall displays. 
Before doing so, one or more answer options must be 
indicated as correct in the ‘Answers’ dialogue box. 
For more information see ‘Voting answers’. To 
enable this option: 

• Select the ‘Results’ menu and click on ‘Correct 
indication’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

Specifying results as percentages 
To specify this option: 

• Select the ‘Results’ menu and click on 
‘Percentage’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 
 

 i   Note 

‘Percentage’ and ‘Absolute’ cannot both be 
selected simultaneously. 

 
 

Specifying results as absolute values 
This option can only be enabled if vote weighting is 
disabled. For more information see ‘Applying vote 
weighting’. To specify this option: 

• Select the ‘Results’ menu and click on 
‘Absolute’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

Displaying results in bar chart form 
To do so: 

• Select the ‘Results’ menu and click on ‘Bar’ then 
‘Results Window’. 

The voting results will be displayed in the form of a 
bar chart. 
 

 

Figure 12 The result bar chart 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

Displaying results in pie chart form 
This option is used with Multi and For/Against 
voting. To specify this option: 

• Select the ‘Results’ menu and click on ‘Pie’ then 
‘Results Window’. 

The voting results will be displayed in the form of a 
pie chart. 

 
Figure 13 The result pie chart 
 
If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

Displaying results in thermometer chart form 
This option is used with Audience Response and 
Rating votings. The voting results are shown as a 
value between one and the number of answer 
options. The diagram below shows five answer 
options, and the result of the vote is therefore a 
number between one and five. A percentage is 
obtained by dividing the result by the number of 



DCN Next Generation Multi Voting en | 15 

 

Bosch Security Systems B.V. | 2005 September | 9922 141 70392 

answer options. To specify this option: 

• Select the ‘Results’ menu and click on 
‘Thermometer’ then ‘Results Window’. 

The voting results will be displayed in the form of a 
thermometer chart. 

 

Figure 14 The result Thermometer chart 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

3.3.4 Inserting into the voting list 
Once you have created a voting, it should be inserted 
into the current script file. A list of currently present 
votings in the current script file (if any) is shown on 
the right hand side of the window. To insert a voting: 

• Click on the arrow-shaped ‘Insert’ push button. 

 i   Note 

The voting will always be inserted at the end of 
the voting list. 

 
If the voting list contains a voting with the same 
voting number as one being inserted, a warning 
message with the following text is displayed: 

‘A Voting already exists with number #. 
Do you want to overwrite?’ 

• Click on the ‘Ok’ push button to continue 
inserting and to overwrite the existing voting. 

 i   Note 

If you select a voting in the voting list, it is 
possible to delete it using the ‘Delete’ push 
button. 

 

3.3.5 Editing existing votings 
It is possible to edit existing votings from the 
currently open script file. The procedure for editing 

an existing voting is almost identical to that for 
creating a new voting. The only differences are that 
you must recall the voting you wish to edit from the 
voting list, and therefore the edit fields are not 
necessarily empty. The specifying of voting number, 
name and kind, voting subject and results display, 
and the insertion into the voting list is carried out as 
for creating a new voting. To enter new information 
into fields that already contain an entry, simply type 
over the existing entry or delete it first and then enter 
the new information. It is not possible to edit a voting 
that has already been voted on, though it can be 
deleted. For more details, see page 11 
 
 
To select a voting for editing: 

• Click on the voting in the voting list. 

• Click on the arrow-shaped ‘Recall’ push button. 

The details of the selected voting will appear in the 
‘Number’, ‘Name’, ‘Kind’ and ‘Subject’ text fields. 

Search 
This option allows you to conduct a search for a 
particular voting in the current script file. The 
‘Search’ facility is located at the bottom right of the 
Preparation window. There are two ‘Search’ radio 
buttons, a ‘Search’ push button and a list box. 
 
You can specify whether the search is conducted by 
voting name or number. The current search mode is 
indicated by a black circle in the appropriate radio 
button, located under the text ‘Search’. To choose 
the other mode: 

• Click on the radio button without the black 
circle. 

A black circle will appear in the newly selected radio 
button. Any searches will be conducted using this 
mode. 
 
You can specify a particular voting to search for by 
entering the voting details in the text box situated 
under the ‘Search’ push button. If ‘Numbers’ has 
been specified for the search, you may only enter up 
to four digits. 
 
If ‘Names’ has been specified, the maximum number 
of characters allowed is the maximum length of the 
voting name. To search for a voting: 

• Type the details of the required voting in the text 
box. 

• Click on the ‘Search’ push button. 

Once the search is completed, the list box displays all 
entries corresponding to the input details. You can 
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select the desired entry by clicking on it. 
 
Votings that have been located using the ‘Search’ 
facility are selected for insertion in the same way as 
those selected from the voting list. 

3.3.6 Editing the current script file 
It is possible to delete votings in the current script 
file, or add votings from another script file. Both 
actions are carried out from the ‘Copy Votings’ 
dialogue box. To access this dialogue box: 

• Select the ‘File’ menu and click on ‘Copy 
Votings...’. 

The ‘Copy Votings’ dialogue box appears: 

 

Figure 15 The ‘Copy Votings’ dialogue box 

Inserting votings into the current script file 
This option allows you to copy votings from another 
script file and insert them into the current one. To 
select the script file which contains the votings you 
wish to copy: 

• Click on the drop-down list box situated at the 
top left corner. 

This opens the list box and displays all available 
script files. 

• Click on the script file you wish to select. 

The name of the script file you have selected will be 
displayed in the dropdown list box. The votings 
contained within this script file are displayed in a list 
box below the file name. To select the voting to be 
copied: 

• Click on the voting to be inserted. 

 i   Note 

You can also search for specific votings you 
wish to copy. For more information, see 
‘Search’. 

• Click on the arrow-shaped ‘Insert’ push button. 

 
 

 i   Note 

If the ‘Current Script:’ list contains a voting 
with the same voting number as one being 
inserted, the inserted voting is shown in the 
‘Current Script:’ list with a new number. After 
inserting a voting, the last selected position in 
the list of votings is maintained. The list does 
not automatically scroll back to the top. 

 

 i   Note 

Votings can only be copied into the ‘Current 
Script:’ list without existing results. 

• Click on the ‘Ok’ push button to continue 
inserting and to overwrite the existing voting. 

Once votings have been inserted, the ‘Total Votings:’ 
figure situated under the ‘Current Script:’ list box will 
be updated to include the newly inserted voting(s). 
The inserted voting(s) are copied from the other 
script file and are no longer displayed in the left-hand 
list box. 

3.3.7 Deleting votings in the current script file 
It is possible to remove votings from the current 
script file. 

• Click on the voting you wish to delete in the 
‘Current Script’ list of the ‘Copy Votings’ dialogue 
box. 

• Click on the ‘Delete’ push button situated under 
the ‘Current Script’ list box. 

When you have finished working in the ‘Copy 
Votings’ dialogue box and wish to exit: 

• Click on the ‘Ok’ push button. 

You can also delete votings from the voting list 
without using the ‘Copy Votings’ dialogue box. To do 
so: 

• Click on the voting to be deleted from the voting 
list in the Preparation window. 

• Click on the ‘Delete’ push button under the 
voting list. 

3.4 Viewing results during or after voting 
The results of the current vote are displayed in the 
Results window. This can be viewed from the 
Control window. 
To view the Results window: 

• select the ‘Results’ menu and click on ‘Results 
Window’. 
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The Results window will appear: 

 

Figure 16 The ‘Results’ window 

 i   Note 

The window shown above is displayed when 
the ‘2 Results’ option in the ‘Results’ window 
is selected. If this option is not selected, only 
one set of results will be shown. 

 
The settings of the Results window are specified in 
the ‘Results’ menu. To alter these settings, see 
‘Specifying settings’ on paragraph 3.5. The window 
consists of the following elements (beginning at top 
left): 
• Voting number text - displays the current voting 

number. 
• Voting name text - displays the name of the 

current voting. 
• Voting subject text - displays the subject of the 

current voting. 
 

 i   Note 

These elements are specified in the 
Preparation window. For more information, refer 
to paragraph 3.1. 

 
• Timer text - displays the timer if the timer is 

enabled. 
• Present - displays the number of delegates taking 

part in a voting. If a second voting is present, this 
text box is also present at the right hand side of 
the window and displays the number of delegates 
taking part in the second voting. 

• Not Voted - displays the number of delegates 
who have not voted. If a second voting is present, 
this text box is also present at the right hand side 

of the window and displays the number of 
delegates who have not voted in the second 
voting. 

 

 i   Note 

If the Quorum and/or Majority options are 
selected, Present and Not Voted are replaced 
by displays giving information about the 
selected quorum and majority as follows: 
Quorum - displays the number of authorized 
delegates who are present 
Req. Quorum - displays the required number of 
delegates as determined by the selected 
quorum 
Not Voted - displays the number of delegates 
who have not voted 
Req. Majority - displays the required majority 
as determined by the selected majority 
Majority - displays the actual majority. 

 
• Results display area - displays the results of the 

current voting (and second voting if selected). 
The way the results are displayed is specified in 
the ‘Results’ menu. Legends are displayed on the 
left. The results can be scrolled up and down 
simultaneously using scroll bars if the number of 
results is too large to fit inside the display area. 

• Rulers - a ruler is displayed with each set of 
results to facilitate the comparison of results. 

• Group list boxes - a list box is displayed 
beneath each set of results. This allows you to 
select which group results should be shown. The 
total results can be selected (‘All’). These groups 
are specified in the Delegate Database module. 

• Voting Approved - this text box indicates 
whether the voting has achieved the majority 
stipulated in the Majority option. It is only 
present if this option is enabled, and the Majority 
option is selected. 

• Voting list box - this list box is displayed 
beneath the second voting display area (if 
present). It allows you to select the voting name 
for the second voting. Any voting in the current 
script can be selected. By default the current 
voting is displayed. 

• Roll Call - this text box displays the name of the 
delegate currently voting for a roll call voting. It 
is only present if the ‘Roll Call’ setting is enabled. 

Specifying which results are displayed 
This option allows you to specify which results are 
displayed in the left-hand and the right-hand result 
display areas of the Results window. 
 
The procedure for both displays is exactly the same. 
The two drop-down list boxes located directly below 
the results display areas of the Results window 
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contain a list of all groups that have been specified 
for the current conference using the Delegate 
Database module. The default setting is ‘All’, so 
voting results of all participants will be displayed. 
The left hand display area refers to the current 
voting. The right hand display area can refer to the 
current voting or to any other voting in the current 
script. To select another group: 

• Scroll through the list and click on the required 
group. 

The results for only that group will be displayed. The 
name of the selected group will appear below the 
results, in the first line of the drop-down list box. To 
specify the voting in the current script to which the 
second display refers, a second drop-down list box 
located under the second results display area allows 
you to select any voting within the current script. By 
default the current voting will be shown. To select 
another voting: 

• Scroll through the list and click on the required 
voting. 

The results for that voting will be displayed. The 
name of the selected voting will appear below the 
results, in the first line of the drop-down list box. 

3.5 Specifying settings 
You can specify a number of voting-related 
parameters using the ‘Settings’ menu of Multi Voting. 
The ‘Settings’ menu can only be accessed from the 
Control window and it is only active if no voting is 
taking place. The following can be specified: 
• Timed vote 
• Legends 
• 100% Votes 
• Open 
• Close 
• Roll Call 
• Auto abstain 
• Voting Chairman 
• Vote weighting 
• Vote Not Revocable 
• Voting LEDs 
• Quorum/Majority 
• To hall displays 
• Attention Tone 
• Automatic Printing 
• Automatic Export 
 

 i   Note 

Automatic Printing is covered in paragraph 
3.6.3. 

3.5.1 Specifying timed vote 
The Multi Voting module incorporates a timer 
facility that allows you to set a time limit for any 
vote. From the ‘Voting Timer’ dialogue box you can 
set the time limit and determine whether the timer is 
activated, and therefore whether the time limit can be 
applied to a vote or not. To do so: 

• Select the ‘Settings’ menu and click on ‘Voting 
Timer...’. 

The following dialogue box will appear: 

 

Figure 17 The ‘Voting Timer’ dialogue box 

In the ‘Minutes’ edit field: 

• Enter the required time limit. 

The up and down arrow buttons on the right-hand 
side of this field can be used to scroll to the required 
number. 
 
You can specify that voting stops automatically when 
the time limit is reached. To do so: 

• Click on the ‘Auto Vote Stop’ tick box. 

A tick (√) indicates that the function is activated. 
To activate the time limit: 

• Click on the ‘Timer On’ tick box. 

A tick (√) indicates that the function is activated. 
Once you have specified all parameters: 

• Click on the ‘Ok’ push button. 

3.5.2 Specifying screen and print legends 
You can specify the legends that appear in the 
Results window and also when printing the results of 
a vote. 

• Select the ‘Settings’ menu and click on ‘Edit 
Legends...’. 

The following dialogue box appears: 
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Figure 18 The ‘Legends’ dialogue box 

From the ‘LCD’ drop-down list box: 

• Select the LCD legend text by clicking on the 
required option. 

There are three options: ‘Yes’, ‘No’, ‘Yes’, ‘No’, 
‘Abstain’ or ‘Yes’, ‘No’, ‘Abstain’, ‘NPPV’.  
In the ‘Screen and Print Legends’ section of the 
dialogue box there are ‘Time’, ‘Not Voted’, ‘Present’, 
‘Casted’ and ‘Authorised’ edit fields. To the right of 
these edit fields there are a number of other edit 
fields (depending on the LCD legend option selected 
above). 
To enter a new legend text: 

• Click on the required edit field. 

• Enter the required legend text. 

You can input a new legend text up to 10 characters. 
Once you have specified all legend texts: 

• Click on the ‘Ok’ push button. 

3.5.3 Specifying open and closed voting 
If you are voting without using a script file or if you 
are voting using the default settings present when the 
application is opened, you can specify whether the 
voting is open or closed. For more information about 
voting without using a script, please refer to 
paragraph 4.2. 
 

 i   Note 

If you have recalled a voting from the current 
script, these options are disabled and can only 
be altered from the Preparation window. 

• Select the ‘Settings’ menu and click on the 
required option. 

A tick mark (√) indicates if the ‘Open’ or ‘Closed’ 
option is enabled. 

3.5.4 Specifying 100% votes 
You can specify how the number of delegates taking 
part in a vote is calculated. 

• Select the ‘Settings’ menu and click on ‘100% 
Votes’. 

The following dialogue box appears: 

 

Figure 19 The ‘100% Votes’ dialogue box 

There are five radio buttons: 
• ‘Present Key’ - This radio button allows you to 

specify that only delegates who have pressed the 
present key on their contribution unit will be 
counted. 

• ‘Present Key + Fraud Switch’ - This radio button 
allows you to specify that only delegates who 
have pressed the present key on their 
contribution unit and simultaneously the fraud 
switch will be counted. 

• ‘External Contact’ - This radio button allows you 
to specify that only delegates who activated their 
external contact will be counted. 

• ‘Valid Votes’ - This radio button allows you to 
specify that only delegates who have cast a valid 
vote will be counted. 

• ‘Authorized Votes’ - This radio button allows you 
to specify that only delegates who have voting 
authorization will be counted. Voting 
authorization is specified in the Delegate 
Database module. 

• Click on the required radio button. 

A black circle will appear in the selected radio 
button. 

• Click on the ‘Ok’ push button. 

 

 i   Note 

Refer to System Installation user manual how to 
setup the Fraud switch and the External 
Contact 
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 i   Note 

The present key is disabled on delegate and 
chairman units if the ‘Valid Votes’ or 
‘Authorized Votes’ setting is selected. 

3.5.5 Specifying roll call 
You can specify whether delegates can vote in any 
order or whether they must vote in an order 
predetermined in the Delegate Database module. In 
a roll call voting, each delegate will be prompted 
when it is time to vote. A delegate can then cast and 
correct a vote within the specified voting time. 
Roll call voting is only possible if a names file is 
open. If a delegate’s seat number is not known, 
his/her ID-card must be inserted into the card reader 
before prompting can take place. 
To enable or disable roll call: 

• Select the ‘Settings’ menu and click on ‘Roll 
Call’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

3.5.6 Specifying auto abstain 
This option allows you to enable an automatic 
abstain function, whereby delegate units register an 
abstention (after access requirements have been 
satisfied) until either ‘Yes’ or ‘No’ is pressed. This 
means the ‘Not Voted’ total will always be zero. As a 
result there will be no ‘Not Voted’ on the screen 
display, hall display, LCD displays of delegate units 
(where applicable) or any printouts of vote results. 

• Select the ‘Settings’ menu and click on ‘Auto 
Abstain’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

3.5.7 Enabling the chairman to vote 
This option allows you to enable a voting chairman 
function, which determines whether the controlling 
chairman is allowed to vote. 

• Select the ‘Settings’ menu and click on ‘Voting 
Chairman’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

3.5.8 Applying vote weighting 
This option allows you to determine whether vote 
weighting specified in the Delegate Database module 

for each delegate, can be applied. To apply vote 
weighting: 

• Select the ‘Settings’ menu and click on ‘Vote 
Weighting’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

3.5.9 Specifying that votes are not revocable 
This option allows you to determine whether 
delegates can change their vote while a voting is 
taking place, or whether having voted once, the vote 
cannot be changed during the same voting. To 
specify that votes cannot be changed, i.e. they are not 
revocable: 

• Select the ‘Settings’ menu and click on ‘Vote Not 
Revocable’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 
 

 i   Note 

’Auto Abstain’ and ‘Vote Note Revocable’ 
cannot be simultaneously selected. 

3.5.10 Enabling the voting LEDs on delegate units 
On delegate units, LEDs are present to indicate each 
answer option. It is possible to determine whether 
these LEDs light when a vote is cast. To select this 
option: 

• Select the ‘Settings’ menu and click on ‘Voting 
LEDs’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 

3.5.11 Sending voting results to hall displays 
This option allows you to determine whether the 
results of a vote can be shown on all hall displays 
connected to the system. To do so: 

• Select the ‘Settings’ menu and click on ‘Hall 
Displays’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 
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 i   Note 

The time to display the voting results on  
Concentus and Hall Displays can be defined in 
the DCNNG.INI file: 
[Common Voting] 
ViewTimeAfterStop = TT 

Where: 
ViewTimeAfterStop The time to display the 
 voting results. TT is 
 between 0 and 200 
 seconds 
If the settings is not in DCNNG.INI the default 
time is 60 seconds. 

 
 

 i   Note 

Normally, the number of delegates present 
during a voting is determined by the number of 
delegates that pressed the ‘PRESENT’ key on 
their units. When the LBB 4175 or LBB 4176 
PC-software is used, this number can also be 
determined by the number of authorized 
delegates in the delegate database (100%-
votes setting set to ‘Authorized’), or the number 
of people that actually casted a vote (100%-
votes setting set to ‘Casted’). In these 2 cases, 
the ‘Present’-legend on the LBB 4183 Text 
Display and the LBB 4184 Video Display will 
switch to ‘Authorized’ or ‘Casted’. However, on 
the unit LCD’s and the LBB 4183 numeric 
displays, this legend will not be changed. This 
might be experienced as confusing. To prevent 
confusion, the display of the number of 
‘Authorized’ or ‘Casted’ delegates on unit 
LCD’s and LBB 4183 numeric displays can be 
disabled. The following DCNNG.INI section 
determines this setting: 
[Startup] 
DisablePresentNumber=No 

Where: 
DisablePresentNumber 
 When set to ‘Yes’, the  
  display of number of  
  Authorized Delegates or 
  Casted Votes will be  
  disabled 

3.5.12 Specifying quorums and majorities 
It is possible to specify the minimum number of 
authorized delegates that must be present before a 
vote can take place. This is called a quorum. It is also 
possible to specify the percentage of votes, which will 
constitute a majority vote. 

Specifying quorums 
It is possible to specify a new quorum or edit existing 
quorums. If a quorum(s) exists, it can be selected and 

enabled or disabled. 
To specify a new quorum, or edit an existing 
quorum: 

• Select the ‘Settings’ menu and click on 
‘Quorum/Majority’. 

• Select ‘Edit Quorums....’ 

The following dialogue box will appear: 

 

Figure 20 The ‘Edit Quorums’ dialogue box 

The dialogue box consists of the following elements: 
• ‘Name’ and ‘Formula’ edit fields 
• ‘Insert’ and ‘Recall’ push buttons 
• A list box of current quorums 
• ‘OK’, ‘Cancel’ and ‘Delete’ push buttons 
 

 i   Note 

The ‘Calculate over:’ part of the dialogue box 
is not active. 

 
To specify a new quorum: 

• Type the desired quorum name in the ‘Name’ 
edit field. 

The ‘Formula’ edit fields allows you to determine 
how the quorum is calculated. They consist of a 
numerator (upper edit field), denominator (lower edit 
field) and constant (right hand edit field). 
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 i   Note 

The value of the numerator divided by the 
denominator is automatically multiplied by the 
number of authorized delegates for calculating 
the quorum. Values will be rounded to the 
nearest integer. 

 
As an example of specifying a quorum, the following 
figures would be entered in the ‘Formula’ edit fields 
to produce a quorum corresponding to over half the 
authorized delegates being present: 
• numerator – 1 
• denominator – 2 
• constant - 1 
 
In the above example, the number of authorized 
delegates would be multiplied by 1/2. The number 
one would then be added to this figure to produce 
the final quorum i.e. over half the authorized 
delegates. 
 

 i   Note 

The figures entered in the numerator and 
denominator edit fields can be a maximum of 
three digits. The denominator cannot be zero. 
The figure entered in the constant edit field can 
be a maximum of four digits, and have a 
maximum value of 1500. 

 
To continue: 

• Enter the desired values in the ‘Formula’ edit 
fields. 

• Click on the ‘Insert’ push button. 

The quorum will now appear in the list box, and can 
be selected from the Control window. 
The procedure for editing an existing quorum is 
almost identical to that for creating a new quorum. 
The only differences are that you must move the 
quorum to the formula edit fields first. To edit an 
existing quorum: 

• Highlight the quorum in the list of current 
quorums. 

• Click on the ‘Recall’ push button. 

Specifying name and formula is carried out as for 
creating a new quorum. 
 

 i   Note 

Any quorum in the list box can be deleted by 
first highlighting it and then clicking on the 
‘Delete’ push button. 

Specifying majorities 
It is possible to specify a new majority or edit existing 
majorities. If a majority exists, it can be selected and 
enabled or disabled. 
To specify a new majority or edit an existing 
majority: 

• Select the ‘Settings’ menu and click on 
‘Quorum/Majority’. 

• Select ‘Edit Majorities....’ 

The following dialogue box will appear: 

 

Figure 21 The ‘Edit Majorities’ dialogue box 

The dialogue box consists of the following elements: 
• ‘Name’ and ‘Formula’ edit fields 
• ‘Calculate over:’ radio buttons 
• ‘Insert’ and ‘Recall’ push buttons 
• A list box of current majorities 
• ‘OK’, ‘Cancel’ and ‘Delete’ push buttons 
 
To specify a new majority: 

• Type the desired majority name in the ‘Name’ 
edit field. 

The ‘Formula’ edit fields allows you to determine 
how the majority is calculated. They consist of a 
numerator (upper edit field), denominator (lower edit 
field) and constant (right hand edit field). 
 

 i   Note 

The value of the numerator divided by the 
denominator is automatically multiplied by the 
option selected in the ‘Calculate over:’ part of 
the dialogue box for calculating the quorum. 
Values are rounded to the nearest integer. 
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The ‘Calculate over:’ radio buttons allow you to 
specify whether the majority is calculated over the 
number of authorized delegates, the number of votes 
excluding abstentions or the total number of votes 
including abstentions. 
As an example of specifying a majority, the following 
settings would be made to produce a majority 
corresponding to over half the authorized delegates 
voting 'Yes' or 'For': 
• numerator – 1 
• denominator – 2 
• constant – 1 
• calculate over: Authorized del. 
 
In the above example, the number of authorized 
delegates would be multiplied by 1/2. The number 
one would then be added to this figure to produce 
the final majority i.e. over half the authorized 
delegates. 
 

 i   Note 

The figures entered in the numerator and 
denominator edit fields can be a maximum of 
three digits. The denominator cannot be zero. 
The figure entered in the constant edit field can 
be a maximum of four digits, and have a 
maximum value of 1500. 

 
To continue: 

• Enter the desired values in the ‘Formula’ edit 
fields, and click on the required radio button in 
the ‘Calculate over:’ window. 

• Click on the ‘Insert’ push button. 

The majority will now appear in the list box, and can 
be selected from the Control window. The procedure 
for editing an existing majority is almost identical to 
that for creating a new majority. The only differences 
are that you must first move the majority to the 
formula edit fields. The specifications are carried out 
as for creating a new majority. To edit an existing 
majority: 

• Highlight the majority in the list of current 
majorities. 

• Click on the ‘Recall’ push button. 

The specifying of name and formula is carried out as 
for creating a new majority. 
 

 i   Note 

Any majority in the list box can be deleted by 
first highlighting it and then clicking on the 
‘Delete’ push button. 

Enabling Quorum and Majority 
To enable Quorum or Majority: 

• Select the ‘Settings’ menu and click on 
‘Quorum/Majority’. 

• Click on ‘Quorum’ or ‘Majority’ as required. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 
 
If a quorum is selected and enabled when the 
Attendance Registration software is not running, the 
following warning message will appear: 

‘Quorum Enabled but Attendance Registration  
is not running. Continue?’ 

• Click on ‘OK’ to vote without attendance 
registration. 

• Click on ‘Cancel’ to return to the Control 
window. 

When either Quorum or Majority are enabled, the 
Quorum/Majority window automatically appears. 
This window contains information about the number 
of authorized delegates present, the required quorum 
and/or majority and the actual majority. An example 
of this window is given below. 

 

Figure 22 The ‘Quorum/Majority’ window 

 

 i   Note 

The information in the Quorum/Majority window 
is updated in real time. This means that the 
information is always up to date. 

 

 i   Note 

The Quorum/Majority window cannot be 
closed, it can only be minimized. 

Approved Text 
It is possible to specify that text will be shown at the 
end of a vote indicating if the vote was passed or 
rejected. To enable Approved Text: 

• Select the ‘Settings’ menu and click on 
‘Quorum/Majority’. 
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• Click on ‘Approved Text’. 

If the option was previously enabled (indicated by a 
tick mark) it will become disabled. If it was disabled, 
it will become enabled (indicated by a tick mark). 
 

 i   Note 

This text will only be shown if a majority is 
selected and enabled. No text will be shown if 
the voting is closed, and no votes have been 
cast. 

3.5.13 Exporting results automatically 
You can specify that the results of a voting are 
automatically exported to DOS file. To do so: 

• Select the ‘Settings’ menu and click on ‘Automatic 
Export...’. 

The following dialogue box will appear: 

 

Figure 23 The ‘Automatic Export’ dialogue box 

To enable or disable automatic export: 

• Click on the ‘Export after stop’ tick box. 

A tick (√) indicates that the function is enabled. 
If you only wish to export the total results of a 
voting: 

• Click on the ‘Total only’ tick box. 

Otherwise the individual results and group results 
will be exported as well. 
A tick (√) indicates that the function is enabled. 
Once you have specified all options: 

• Click on the ‘Ok’ push button. 

3.6 Printing 
It is possible to print hard copies of votings and their 
results. You can print an entire script file, or you can 
print copies of the results of one or more votings 
from the currently open script file. It is also possible 
to specify that the results of a voting are printed 
automatically when the voting is finished. 

3.6.1 Printing script files 
It is possible to print a hard copy of a script file. This 

contains information such as voting name, voting 
number, voting subject and the answer options, 
which can be voted on. You can also specify print-
related parameters. To print a script file: 

• Select the ‘File’ menu and click on ‘Print 
Script...’. 

The following dialogue box appears: 

 

Figure 24 The ‘Print Script’ dialogue box 

• Select the ‘Page Header:’ text box. 

A descriptive name of the voting may be entered up 
to 80 characters long. This text box may be left 
blank. 

• Select the ‘Number of Copies:’ field and type in 
the required number (maximum nine). 

 i   Tip 

The up and down arrow buttons on the right-
hand side of this field can be used to scroll to 
the required number. 

• Click on the ‘Print’ push button. 

A copy of the script file will be printed. 

3.6.2 Printing voting results 
It is possible to print a hard copy of the voting results 
from the currently open script file. You can conduct 
a search for the voting whose results you wish to 
print, and also specify print-related parameters. All of 
this is carried out from the ‘Print Results’ dialogue 
box. 

• Select the ‘File’ menu and click on ‘Print 
Results...’. 
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The following dialogue box will appear: 

 

Figure 25 The ‘Print Results’ dialogue box 

To select the voting results you wish to print: 

• Click on the required voting from the ‘Voting:’ 
drop-down list box. 

 i   Note 

You can also initiate a search to locate the 
voting results you wish to print (see ‘Search’ 
on page 15). 

 
To specify the title of the printed voting result: 

• Select the ‘Page Header:’ text box. 

A descriptive name of the voting may be entered up 
to 80 characters long. This text box may also be left 
blank. You can specify whether the print out of the 
selected voting includes the total results, group 
results, individual results or the names of delegates 
who abstain from voting. 

 i   Note 

Any combination of ‘Total’, ‘Group’, 
‘Individual’ and ‘Abstain votes’ can be 
chosen. 

 

 i   Note 

If ‘Abstain votes’ is chosen, the names of 
abstaining delegates will be printed whether 
the voting is open or closed. 

 
To include the total result: 

• Click on the ‘Include Total Results’ tick box. 

To include group results: 

• Click on the ‘Include Group Results’ tick box. 

To include individual results: 

• Click on the ‘Include Individual Results’ tick box. 

To include the names of abstaining delegates: 

• Click on the ‘Abstain votes’ tick box. 

A tick (√) indicates that these functions are enabled. 
You can also specify whether individual results are 
sorted according to group or answer option. When 
sorted by group, individual results for each answer 
option are displayed, group-by-group. The groups to 
which delegates belong are created using the 
Delegate Database module. When sorted by answer, 
a list of individual results will be given for each 
answer option. 
 

 i   Note 

The ‘Sort by’ options are only active when 
‘Individual Results’ is selected in the ‘Include’ 
group. Individual results cannot be sorted by 
group and answer simultaneously. 

 
To sort by group: 

• Click on the ‘Sort by Group’ tick box. 

To sort by answer: 

• Click on the ‘Sort by Answer’ tick box. 

• Select the ‘Number of Copies:’ field and type in 
the required number (maximum nine). 

A tick (√) indicates that these functions are enabled. 
 

 i   Tip 

The up and down arrow buttons on the right-
hand side of this field can be used to scroll to 
the required number. 

 
Once you have specified all parameters: 
Click on the ‘Print’ push button. 
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Print a multiple choice report 
It is possible to print a multiple choice voting script. 
 

 i   Note 

This is only possible if the script contains 
multiple choice questions and no information of 
other voting types 

 
To print a multiple choice voting script: 

• Select the ‘File’ menu and click on ‘Multiple 
Choice’. 

• From the drop-down menu click on ‘Print 
Report’. 

The following dialogue box will appear: 

 

Figure 26 The 'Print MC Report' dialog box 

• Select the ‘Page Header:’ edit field. 

A descriptive name of the voting may be entered up 
to 80 characters long. This text box may be left 
blank. 
 
You can specify whether the total results only should 
be printed. To do this: 

• Click on the ‘Total only’ tick box. 

A tick (√) indicates that this function is enabled. 

• Select the ‘Number of Copies:’ field and type in 
the required number (maximum nine). 

 

 i   Tip 

The up and down arrow buttons on the right-
hand side of this field can be used to scroll to 
the required number. 

 
Once you have specified all parameters: 

• Click on the ‘Print’ push button. 

3.6.3 Printing voting results automatically 
It is possible to specify that the results of a voting be 
automatically printed when the voting is finished. To 
do so: 

• Select the ‘Settings’ menu and click on ‘Automatic 
Printing...’. 

The following dialogue box appears: 

 

Figure 27 The ‘Automatic Print’ dialogue box 

To enable or disable automatic printing: 

• Click on the ‘Print after stop’ tick box. 

A tick (√) indicates that the function is enabled. 
You can also select printing parameters. To specify 
the title of the printed voting result: 

• Select the ‘Page Header:’ text box. 

A descriptive name of the voting may be entered up 
to 80 characters long. This text box may also be left 
blank. You can specify whether the print out of the 
selected voting includes the total results, group 
results, individual results or the names of the 
delegates who abstained from voting. 
 

 i   Note 

Any combination of ‘Total’, ‘Group’, 
‘Individual’ and ‘Abstain votes’ can be 
chosen. 

 

 i   Note 

If ‘Abstain votes’ is chosen, the names of 
abstaining delegates will be printed whether 
the voting is open or closed. 
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To include the total result: 

• Click on the ‘Include Total Results’ tick box. 

To include group results: 

• Click on the ‘Include Group Results’ tick box. 

To include individual results: 

• Click on the ‘Include Individual Results’ tick 
box. 

To include the names of abstaining delegates: 

• Click on the ‘Abstain Votes’ tick box. 

A tick (√) indicates that the function is enabled. 
You can also specify whether individual results are 
sorted according to group or answer option. When 
sorted by group, the individual results for each 
answer option are displayed, group-by-group. The 
groups to which delegates belong are created using 
the Delegate Database Module. When sorted by 
answer, a list of individual results will be given for 
each answer option. 
 

 i   Note 

The ‘Sort by’ options are only active when 
‘Individual Results’ is selected in the ‘Include’ 
group. Individual results cannot be sorted by 
group and answer simultaneously. 

 
To sort by group: 

• Click on the ‘Sort by Group’ tick box. 

To sort by answer: 

• Click on the ‘Sort by Answer’ tick box. 

It is possible to specify text that will appear at the 
end of the printout. This could be, for example, the 
name of the chairman of the congress, though any 
desired text could be specified. To do so: 

• Select the ‘Report Trailer:’ text box. 

Text may be entered up to 80 characters long. This 
text box may also be left blank. 
Once you have specified all parameters: 

• Click on the ‘Ok’ push button. 
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4 Controlling voting 

4.1 The control window 
The Control window of the Multi Voting module is 
used to recall votings and to start, control and stop 
the voting process itself. You can also access the 
menu bar, which allows you to specify viewing 
options and settings, print, and work with script files. 
To go to the Control window from the Preparation 
window: 

• Click on the ‘Control!’ menu option situated on 
the menu bar. 

The Control window appears: 

 

Figure 28 The Control window 

 i   Note 

The Control window cannot be opened if there 
is no connection to the Central Control Unit 
(CCU). 

 
When all elements of the Control window are 
displayed and voting is not in progress, the following 
can be seen: 
• ‘Number’ and ‘Name’ text fields 
• ‘Start’ and ‘Stop’ voting push buttons 
• ‘Present’ and ‘Not Voted’ texts 
 

 i   Note 

If the Quorum option is enabled and a quorum 
is selected, the ‘Present’ text is replaced by a 
‘Quorum:’ text. The Quorum option is only 
available for parliamentary voting and 
For/Against voting. 

 
• Timer 
• ‘Previous’ and ‘Next’ voting selection push 

buttons 
• ‘Recall’ voting push button 
• ‘Search’ (for a voting) radio buttons, push button 

and list box 

• Voting list. 
 

 i   Note 

If voting is in progress, the ‘Start’ push button 
will display the text ‘Hold’ or ‘Restart’. 
Depending on what has been specified in the 
‘View’ and ‘Settings’ menus, various elements 
listed above may not be displayed. 

 

 i   Note 

If the Quorum and/or Majority options are 
selected, a ‘Requested Quorum’ and/or 
‘Requested Majority’ drop-down list box will 
be present. Each of these boxes also has a 
smaller text field to the right showing the real 
time values of the quorum and majority. 

 
If a script file is currently open, the name of the 
script file will be displayed in the title bar at the top 
of the Control window. Votings contained within that 
script file will be displayed in the list box on the right 
side of the control window. If there are more votings 
than can be displayed, a scroll bar is available. If 
there is no voting currently selected or if there is no 
script file currently open, the ‘Name’ edit field is 
empty and the ‘Number’ text field displays ‘1’. 

4.2 Voting without a script 
While most voting is carried out using pre-prepared 
scripts, it is also possible to vote without such a script. 
In this case, a default voting script will be used. 

 i   Note 

This is only possible if there is no script file 
open, i.e. if the software has been started up 
but no file has been opened, imported or 
created. 

 
If the program is open in the Control window, you 
have the same access to voting functions as when a 
script file is open and a voting recalled. You need not 
specify any vote-related parameters (such as open or 
closed vote, time limit etc.) in order to vote. However 
if you wish to do so, see paragraph 3.3.2. 
 
Starting and controlling the vote is carried out in 
exactly the same manner as for voting using a pre-
prepared script - refer to ‘Starting Voting’. 
 
Once a vote has been carried out without a pre-
prepared script, the results of the vote are stored in a 
script file called defmv.dat. This file name will appear 
at the top of the Control window once the voting has 
been completed and the results saved. This script file 
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exists solely to save the results of unscripted votes, 
and can only contain one voting with results. If 
another unscripted vote takes place, the vote results 
will be written over the existing data in this file. 
 

 

Figure 29 Voting without a script 

4.3 Voting using a script 

Selecting a voting 
This feature allows you to select a voting from the 
voting list. It is available from the Control window, if 
you are working in a script file with votings or have 
created a voting in the Preparation window. 

• Click on the voting you wish to select. 

• Click on the arrow-shaped ‘Recall’ push button. 

The details of the selected voting will appear in the 
‘Number’ and ‘Name’ text fields. If the timer is 
enabled, the time limit for the selected motion will be 
displayed (in minutes:seconds) once voting starts. To 
enable the timer, or alter the time allowed, see 
‘Timed Vote’. 
 

 i   Note 

You can also initiate a search to locate a 
particular voting. Please refer to the procedure 
described for the ‘Search’ facility in the 
Preparation window. 

 
Once you have selected a voting, you can start 
voting. 

Selecting the next voting 
This option allows you to select the voting situated 
below the one currently selected in the voting list. 

 

Figure 30 Voting using a script 

• Click on the ‘Next’ push button. 

The details of the ‘next’ voting will appear in the 
‘Number’ and ‘Name’ text fields. 
If a voting was already recalled, it will be replaced by 
the ‘next’ voting and inserted back into the voting list 
in its original position. If there is no voting currently 
selected, the first voting in the voting list is selected. 

Selecting the previous voting 
This option allows you to select the voting situated 
above the one currently selected on the voting list. 

• Click on the ‘Previous’ push button. 

The details of the ‘previous’ voting will appear in the 
‘Number’ and ‘Name’ text fields. 
 

 i   Note 

If a voting was already recalled, it will be 
replaced by the ‘previous’ voting and inserted 
back into the voting list in its original position. If 
there is no voting currently selected, the first 
voting in the voting list is selected. After 
recalling a voting, the last selected position in 
the list of votings is maintained. The list does 
not automatically scroll back to the top. 

4.3.1 Selecting a quorum and majority 
From the Control window, it is possible to select a 
quorum or majority. The quorums and majorities are 
created and edited from the Preparation window. For 
more information, please refer to paragraph 0 

Selecting a quorum 
This is done using the ‘Requested Quorum:’ 
dropdown list box, which contains the names of all 
the quorums, which have been created. There is also 
a 'None' option, if you do not wish to specify a 
quorum. To select a quorum: 

• Use the arrow key to view the choices. 

• Click on the required selection. 

When a quorum is selected, the text field to the right 
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of the ‘Requested Quorum:’ drop-down list box shows 
the calculated value of the quorum. 
 

 i   Note 

The ‘Quorum’ text box in the lower left corner 
of the Control window shows the number of 
authorized delegates present. 

Selecting a majority 
This is done using the ‘Requested Majority’ dropdown 
list box, which contains the names of all the 
majorities, which have been created. There is also a 
'None' option, if you do not wish to specify a 
majority. To select a majority: 

• Use the arrow key to view the choices. 

• Click on the required selection. 

When a majority is selected, the text field to the right 
of the ‘Requested Majority:’ drop-down list box shows 
the calculated value of the majority. 

4.3.2 Starting voting 
Before the voting start it is possible to activate an 
attention tone. This attention tone can be used to 
page the delegates before the vote starts. To activate 
an attention tone: 

• Click on the ‘Page’ push button. 

Once you have paged the delegates, you can start a 
vote on the selected motion. To start voting: 

• Click on the ‘Start’ push button. 

If you attempt to start voting on a motion that has 
already been voted on, a message will be displayed 
with the following text: 

‘Voting results exist for this motion.  
Overwrite?’ 

• Click on the ‘Ok’ push button to continue voting 
and to overwrite the existing motion. 

• Click on the ‘Cancel’ push button to stop voting. 

Once the voting procedure is initialised, the delegates 
can start casting their votes. The ‘Next’ and ‘Recall’ 
push buttons are disabled while voting is taking 
place. If the timer is enabled, the ‘Time’ display will 
be updated every second to show the available time 
left to vote. If the ‘Interim Results’ option is enabled, 
the incoming votes will be displayed on screen. It is 
possible to control a vote, which is taking place. 

4.3.3 Controlling voting 
While voting is taking place it is possible to hold, 
restart or stop the voting. Holding and restarting is 
accomplished using the push button which initially 

displayed the ‘Start’ text, whose function and text 
changes depending on the state of the voting. The 
full range of possibilities for this push button are: 
• Before voting has been started, the push button 

displays the text ‘Start’ and is used to start voting. 
• Once voting has started, the push button displays 

the text ‘Hold’ and is used to suspend voting. 
• If voting has been suspended, the push button 

displays the text ‘Restart’ and is used to restart 
voting. 

• Once voting has been restarted, the push button 
displays the text ‘Hold’ and is used to suspend 
voting. 

• Once voting has been completed, (and the ‘Stop’ 
push button has been pressed), the push button 
displays the text ‘Start’ and is used to start voting 
(on a new voting, or to re-vote on the same 
motion). 

 

 i   Note 

The voting state can also change due to the 
action of the timer. If a time limit has been 
specified and ‘Auto Vote Stop’ is active, voting 
is suspended once the time limit is reached. 
The push button will display the text ‘Start’ and 
can be used to restart voting. If ‘Auto Vote 
Stop’ is not active voting can still continue until 
manually stopped. To enable the timer or alter 
the time allowed, see Timed Vote. 

 
To stop a vote: 

• Click on the ‘Stop’ push button. 

When you click on ‘Stop’, delegates will be unable to 
cast any more votes. Any conferencing facilities 
suspended during voting will be restarted. The timer 
is reset, and the push button alongside ‘Stop’ displays 
the text ‘Start’ and is used to start voting (on a new 
motion or to re-vote on the same motion). 

4.4 Exiting Multi Voting 

4.4.1 Temporarily exiting Multi Voting 
It is possible to temporarily leave Multi Voting 
without closing it down completely. To do so: 

• Click on the minimize button situated at the top 
right of the application window. 

The Multi Voting program will become iconized in 
the Windows Taskbar. To re-enter Multi Voting: 

• Click on the Voting icon. 

4.4.2 Permanently exiting Multi Voting 
If you wish to exit Multi Voting completely: 



DCN Next Generation Multi Voting en | 31 

 

Bosch Security Systems B.V. | 2005 September | 9922 141 70392 

• Select the ‘File’ menu and click on ‘Exit’. 
If you have requested to exit before saving a script 
file that has changed, a warning message with the 
following text is displayed: 

‘Changes have been made to <filename>. 
Do you want to save?’ 

• Click on the ‘Yes’ push button to save the 
changed script file and exit the program. 

• Click on the ‘No’ push button to exit without 
saving the changed script file. 

• Click on the ‘Cancel’ push button to return to the 
program without exiting. 

When you exit Multi Voting you will return to the 
Windows desktop. 
 

 i   Tip 

You can also exit Multi Voting by clicking on 
the 'close' button on the far top right corner of 
the window. 

 

 i   Note 

By closing the Startup program, all applications 
- including Multi Voting - will close. 
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5 Voting import/export 

5.1 Introduction 
The DCN Next Generation Voting applications can import voting scripts and export voting results. The 
voting import and export takes into account the ImportSeparator setting in the Database section of 
DCNNG.INI: 

[Database] 
ImportSeparator=, 

This setting determines what character is used to separate fields in import and/or export files. The default 
separator is a comma (“,”). The default separator will be used when no separator is specified in the 
DCNNG.INI-file. 

5.2 Import voting script 

5.2.1 Introduction 
In voting scripts the DCN Next Generation operator can prepare a voting even if the DCN Next Generation 
system is not running. A voting script is a simple ASCII file that describes one or more voting rounds. The 
default extension of the voting script file is “imp”, but voting script files with different extension can be 
imported also. When imported into the DCN Next Generation, these voting rounds are the same as those 
made with the Multi and/or Parliamentary Voting applications. 

5.2.2 Import file layout 
Settings that do not apply for a particular type of vote are simply ignored, but the separator characters that 
delimit these entries must be present. 
File starts with the line: 

DCNNG VOTING SCRIPT x.0<SEP>script name<EOL> 

where: 
DCNNG VOTING SCRIPT 
x.0 

Indicates the type of file and the version of DCN Next 
Generation required to handle it. (required entry) In this 
fixed text, the letter ‘x’ represents the major version 
number of the DCN Next Generation software. 

script name Name of the script to be stored in the database. 8 
characters maximum. A script cannot be imported if it has 
a name which is already present in the DCN Next 
Generation system. (required entry). 

<SEP> Indicates a separator character. 
<EOL> Indicates an end of line (carriage return (0x0D) and 

newline character(0x0A)). 

A 2-line entry follows for each vote: 
First line: 

voting number<SEP>voting name<SEP>voting subject<SEP>voting 
kind<SEP>voting menu<SEP>not used<SEP>not used<SEP>interim 
results<SEP>number of answers<EOL> 

where: 
voting number This must be in the range 1-9999. (The default is 1 for the first 

vote and is incremented for each subsequent vote in the script.) 
voting name 20 characters maximum. Default empty. 
voting subject 132 characters maximum. Default empty. 
voting kind A number in the range 1-6 that specifies the type of vote: See 

table 1 for explanation. The default is 1 for the first vote and is 
the previous value for subsequent votes. 

voting menu A number in the range 1-7 that specifies the layout for the 
possible answers on the delegate LCD screens: See table 2 for 
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explanation. The default is 1 for the first vote and is the previous 
value for subsequent votes. 

Not used The fields are not used, and can be left blank. 
interim results A number in the range 0-4 that specifies the interim results 

setting. See table 3 for an explanation of these values. The default 
is 0 for the first vote and is the previous value for all subsequent 
votes. 

number of answers A number that indicates how many answers are possible in this 
vote. This is a required entry. There is no default. 

<SEP> Indicates a separator character. 
<EOL> Indicates an end of line (carriage return (0x0D) and newline 

character(0x0A)). 

Table 1: Voting kind numbering  Table 2: Voting menu settings  Table 3: Interim results settings 
1 Parliamentary vote  1 Yes, No  0 None 
2 For/Against vote  2 Yes, No, Abstain  1 Total 
3 Audience Response vote  3 For, Against  2 Total + Individual 
4 Rating vote  4 --, -, 0, +, ++  3 Total on PC only 
5 Multiple Choice vote  5 1, 2, 3, ...  4 Total + Individual on PC 

only 
6 Opinion Poll vote  6 A, B, C, ...    
   7 ..., C, B, A    
   8 Yes, No, Abstain, NPPV    

Second line: 
answer legend<SEP>answer text<SEP>answer correct<EOL> 

where: 
answer legend Legend text for this answer (10 characters maximum). 
answer text Descriptive text for this answer (66 characters maximum). 
answer correct In a multiple choice vote, this setting indicates whether the 

answer is correct (TRUE) or incorrect (FALSE). 

 

 i   Note 

This line is repeated for the number of answers. 

5.3 Export voting results 

5.3.1 Introduction 
In DCN Next Generation Voting applications, it is possible to automatically save the final voting results for a 
single voting round. This section specifies the layout of such an export file. 

5.3.2 Results export file layout 
The results export file is composed of the following lines of data (in this order): 

Identification This section is the 1st line in the file. 
answer legend This section consists of lines repeated for each possible answer in 

this vote (see table 1, section 5.2.2 ). 
date and time This section contains the date and time the voting was stopped. 
total results This section consists of a part with a fixed number of lines with the 

totals and a part consisting of lines repeated for each possible 
answer in this vote (see table 1, section 5.2.2 ). I.e. totals per 
answer. 

individual results This section is conditional and consists of a line for each delegate. 
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Identification 
DCNNG RESULT x.0<SEP>voting number<SEP>voting name<SEP>voting 
subject<SEP>voting kind<SEP>number of answers<EOL> 

where: 
DCNNG RESULT x.0 Indicates the type of file and the version of DCN Next 

Generation that produced it. In this file type indication, the letter 
‘x’ represents the major version number of the DCN Next 
Generation software. 

voting number A number in the range 1-9999. 
voting name The name of the vote. 
voting subject The voting subject text. 
voting kind A number in the range 1-7 that specifies the type of vote: See 

table 1 for explanation. 
number of answers The number of possible answer options in this vote. 

Answer legend 
This line is repeated ‘number of answers’ times: 

answer legend<SEP>answer text<SEP>answer correct<EOL> 

 where: 
answer legend Legend text for the answer. 
answer text Descriptive text for the answer. 
answer correct In a multiple choice vote, this setting indicates whether the 

answer is correct (TRUE) or incorrect (FALSE). 

Date and time 
This line contains the date and time the voting was performed (the exact time will indicate the time the voting 
is stopped). 

DD-MM-YYYY  HH:MM<EOL> 

 where: 
DD-MM-YYYY Date of voting, DD = day (2 digits), MM = month (2 digits), 

YYYY = year (4 digits). 
HH:MM Time of voting, HH = hour (2 digits, 24 hour military time 

format), MM = minutes (2 digits) 

Total results 
total voting results<EOL> 
present legend<SEP>number of present<EOL> 
not voted legend<SEP>number of not voted<EOL> 
quorum name<SEP>required quorum<SEP>authorized delegates<EOL> 
majority name<SEP>required majority<SEP>majority<EOL> 

 where: 
total voting results The average result (0-1000) of an Audience Response or Rating 

type voting. 
present legend Legend text 
number of present The number of voters registered as present 
not voted legend Legend text 
number of not voted The number of present voters who have not voted 
quorum name The name of the used Quorum formula 
required quorum The number of authorized delegates that must be present for a 

voting to become approved, it will be 65535 (0xFFFF) when no 
quorum is required 

authorized delegates The number of authorized delegates present 
majority name The name of the used Majority formula 
required majority The number of “for”- or “yes”-votes necessary for a voting to 

become approved, it will be 4294967295 (0xFFFFFFFF) when no 
majority is required) 

Majority The number of “for”- or “yes”-votes 
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This line is then repeated ‘number of answers’ times: 

answer option legend<SEP>answer option result<SEP><EOL> 

 where:  
answer option legend Answer text 
answer option result The number of voters who selected this answer. 

Individual results 
This line is repeated for each delegate (if selected): 

delegate id<SEP>screen line<SEP>group<SEP>answer legend<EOL> 

where: 
delegate id A number in the range 1-1000 (single CCU) or 1-1500 (multi-

CCU) that identifies the delegate in the delegate database. Each 
delegate has a unique ID-number. 

Screenline Text of 33 characters which identifies the delegate as text. Can be 
generated by either the DB application or using DCNNGAPI. 

Group The name of the group for this delegate as determined by the 
names file. If the delegate is not associated with a group this part 
is empty. 

answer legend The legend of the answer given by the delegate. 
 

5.4 Export Multiple Choice voting script + results 

5.4.1 Introduction 
In the Multiple Choice Voting application, it is possible to save a script and any voting results in a single 
export file. It is a special kind of export file as it only contains Multiple Choice voting and contains the 
information of all votings in the script. 

5.4.2 Script + results export file layout 
The results export file is composed of the following lines of data (in this order): 

identification This section is the 1st line in the file. 
voting info This section consists of a part with a fixed number of lines with the 

voting description and a part consisting of lines repeated for each 
possible answer in this vote. 
This entire section is repeated for each voting in the script. 

individual results This section consists of one fixed line plus one line per voting for 
each delegate with voting authorization. 

Identification 
DCNNG MC RESULT x.0<SEP>script name<SEP>number of votings<EOL> 

where: 
DCNNG MC RESULT 
x.0 

Indicates the type of file and the version of DCN Next 
Generation that produced it. In this file type indication, the letter 
‘x’ represents the major version number of the DCN Next 
Generation software. 

script name Name of a script (20 characters maximum). 
number of votings The number of votings in the script. 

Voting info 
This entire section is repeated ‘number of votings’ times. 

voting number<SEP>voting name<SEP>voting subject<SEP>number of 
answers><EOL> 

where: 
See page 34 for a description of the fields. 
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This line is then repeated ‘number of answers’ times: 
answer legend<SEP>answer text<SEP>answer correct<EOL> 

where: 
See page 34 for a description of the fields. 

Individual results 
This entire section is repeated for each delegate with voting authorization. 

delegate id<SEP>screenline<SEP>group<SEP>number of correct 
answers<EOL> 

where: 
number of correct 
answers 

The number of answers given by the delegate which matched the 
answer with correct indication on in the script. 

 
See page 35 of the description of the fields not described here.  

 
This line is then repeated ‘number of votings’ times: 

answer legend<EOL> 

where: 
See page 34 for a description of the fields. 
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